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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

 

Intended Audience 

This User Guide is intended for the following audience: 

 Persons in charge of introducing automation devices. 

 Persons who design automation systems. 

 Persons who install or connect automation devices. 

 Persons who manage working automation installation. 

 

 

 

 

 

  Warnings: 

 Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

 Improper use of this product may severely damage the controller. 

 Refer to the controller’s User Guide regarding wiring considerations. 

 Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 

 

 



 

Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

 Systems, machines, and equipment that could present a risk to life or property. 

 Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

 Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 

 



 

Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 

 

 

 

 

 



 

Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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 General Description Wi-Fi & Bluetooth CONTROLLER 1

 

 Zone - Nomenclature 1.1

The nomenclature shown in this point will be used in the whole User Guide, so it is 

important to understand this nomenclature. 

The nomenclature to differentiate the zones is based on the Alphabet, being A the 

shield from below and D the shield from above. The nomenclature is represented on 

the picture below: 

  

 

 

 

 

 

 

 The inputs in the zone B are named I0.X, being X any number suitable in the 
Shield. Digital Outputs are named as Q0.X and Analog Outputs as A0.X. 

 The inputs in the zone C are named I1.X, being X any number suitable in the 
Shield. Digital Outputs are named as Q1.X and Analog Outputs as A1.X. 

 The inputs in the zone D are named I2.X, being X any number suitable in the 
Shield. Digital Outputs are named as Q2.X and Analog Outputs as A2.X. 
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 Zone Distribution 1.2

 

 

 A Zone Features 1.3

Shield A Zone 

 
 
 
 
 

Communication 
Shield 

(1x) Ethernet 
(1x) USB 
(1x) I2C 
(3x) TTL 
(1x) RS-232 
(1x) HALF/FULL Duplex RS-485 
(1x) SPI external Port 
(1x) RTC 
(1x) uSD Socket 
(1x) WiFi & BLE  
 

 

 

 

 

 

 

 

 

 

 



 

 Mechanical dimension 1.4

 

 

 

 

 

 

 

 

 

 

 

M-Duino 3 BLOCK I/Os 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.  



 

 General Features  1.5

 

CONECTABLE PLC ARDUINO 24Vcc M-DUINO 

MODEL TYPE              WiFi & BLE Controller General Spec.  

Input Voltage 12 to 24Vdc 
Fuse protection (2.5A) 

Polarity protection 
 

I max. 1.5A  

Size 101x119.5x94.7 101x119.5x119.3 

Clock Speed 16MHz  

Flash Memory 256KB of which 8KB used by bootloader  

SRAM 8KB  

EEPROM 4KB  

Communications 
I2C  –  Ethernet Port – USB –  WiFi &BLE –  RS485 – RS232 -- SPI 

– (1x) Rx, Tx (Arduino pins) 
Max232-Max485-W5500-ESP32 

USB consideration! 
Only meant for uploading or debugging, not always connected 

as a serial in a project! 
Cannot be working in a final 

application 

An/Dig Input 10bit 
(0-10Vcc) 

0 to 10V 
Input Impedance: 39K 
Separated PCB ground 

 

Digital Isolated Input (24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

 

 

* Interrupt isolated Input HS 
(24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

 

 

Analog Output 8bit 
(0-10Vcc) 

0 to 10Vdc  
I max: 20 mA 

Separated PCB ground 
 

 

Digital Isolated Output (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

 

Imax 24Vdc: 410 mA 

PWM Isolated Output 8bit 
(24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

 

 

Expandability I2C - 127 elements   -  Serial Port RS232/RS485/WiFi/BLE  

* By using this type of signal can no longer use Digital signal (24Vdc)   



 

 Technical Specifications: 2

 General Specifications: 2.1

Item M-DUINO B ZONE 

Power supply 
voltage 

DC power supply 12 to 24Vdc 

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply 
voltage 

24Vdc 

Power supply 
output capacity 

700Ma 

Insulation resistance 20MΩ min.at 500Vdc between the AC terminals and the protective earth terminal. 

Dielectric strength 
2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the 
external AC terminals and the protective ground terminal. 

Shock resistance 80m/s
2
 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 45ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 860g max. 

 
 

 Performance Specification: 2.2

Arduino Board ARDUINO MEGA 2560 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a 
programming language. “similar to the C”.  http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega2560 

Flash Memory 256KB of which 8KB are used by the bootloader 

Program capacity (SRAM) 8KB 

EEPROM 4KB 

Clock Speed 16MHz 

Clock Speed 16MHz 

 

http://arduino.cc/en/Tutorial/HomePage


 

 Precautions 3

Read this manual before attempting to use the WiFi & BLE PLC and follow its descriptions for 

reference during operation. 

 Arduino Board 3.1

The MDUINO PLC ARDUINO ETHERNET & WIFI & BLE 58 I/Os ANALOG/DIGITAL PLUS includes 

an Arduino Mega Board as controller and a ESP32 Dev programmable chip as a Wi-Fi & BLE 

gateway.  

 Intended Audience 3.2

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 3.3

The user must operate M-Duino according to the performance specifications described in this 

manual. 

Before using the MDUINO PLC ARDUINO ETHERNET & WIFI & BLE 58 I/Os ANALOG / DIGITAL 

PLUS under different conditions from what has been specified in this manual or integrating 

into nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems, 

medical equipment, amusement machines, safety equipment and other systems, machines, 

and equipment that may have a serious influence on lives and property if used improperly, 

consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance 

characteristics of the Ethernet/WiFi/BLE Controller are sufficient for the systems, machines, 

and equipment, and be sure to provide the systems, machines, and equipment double safety 

mechanisms. This manual provides information for programming and operating the MDUINO 

PLC ARDUINO ETHERNET & WIFI & BLE 58 I/Os ANALOG / DIGITAL PLUS.  

 

 Software interface 4

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no 

needed to define the pins and if that pins are inputs or outputs. Everything is set up 

automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 



 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards Manager URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: … -> Boards Manager 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json


 

 

 

 

5. Search for “industrialshields” on the browser. 

 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following these steps you will be able to see now the Industrial Shields Boards: 



 

 

 

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools: 

There, it can be selected the exact model for every family. 

 



 

 

 

Also there are some examples of programming in File -> Examples -> M-Duino Family. 

Furthermore there are some extra libraries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://github.com/IndustrialShields/


 

 How to connect PLC Arduino to PC 5

- Connect USB port from PLC to PC.  

NOTE:  
M-Duino Family uses USB-B cable.  
 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> M-Duino Family 
 
 
 

- Select the correct M-Duino Board: 
M-Duino 58+ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Select correct port. 

 

 

 

 

 

 

 

 

 



 

 How to connect PLC to power supply 6

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 

 

  

- Suggested power suppliers

  

 

 

 

 

 

 

 

 

 

 

* Not recommended for industrial applications. The 

Jack connector needs to be removed and use the live 

and GND connectors.   



 

 M-duino Family Pinout 7

 A Zone connection 7.1

 

 

 

 

 

 

 

 

 

 

 

 

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device. 
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RX0 
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TX 
RX 
Z- 
Y+ 
B- 
A+ 
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Reset 
Vin5 
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GND 
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RX2(serial 2) 
TX2(serial 2) 
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IOREF2 
IOREF1 

7Vdc 
GND 

3.3Vdc 
GND 
5Vdc 
GND 

AREF 
IOREF2 
IOREF1 

7Vdc 
GND 

3.3Vdc 
GND 
5Vdc 

GND 

Arduino PIN 
Arduino PIN 
Arduino PIN 

- 
GND 

Arduino PIN 
GND 

- 
GND 

 
 
 
Configuration Switch* (see section 8 for 
configuring the communications. 
Enabling communications disables some 
I/Os) 
 
 
 
 
Communication Pins (Serial 1 is used by 
the ESP32 Wi-Fi & BLE integrated 
module) 
 
 
 
 
 
 
Power supply connectors  
(24Vdc – GND) 

                                                      

 



 

 

 

 

 

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using 

serial communication. When uploading code to Arduino Mega set switch to ON.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ethernet            Arduino                                               Power 
Connector         Reset button        
                                                            USB programmer                         Autoreset 
          connector   

   



 

 B Zone (Analog Shield)  7.2

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

 

                                                           
1 See section 8 to select suitable switch configuration for enable these connections. 
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Digital/PWM Out 
Digital/PWM Out 

Digital Out 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

Led indicator I/Os state 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference  for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Top Zone 



 

 C Zone (Analog Shield) 7.3

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

  

 See section 8 to select suitable switch configuration for enable these connections 
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Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Led indicator I/Os state 

Top Zone 



 

 D Zone (Analog Shield) 7.4

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

See section 8 to select suitable switch configuration for enable these connections.  
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I2.12 
I2.11 
I2.10 
I2.9 
I2.8 
I2.7 

(-)I2.6/INT1 
I2.6/INT1

1
 

(-)I2.5/INT0 
I2.5/INT0

1
 

(-)I2.4 
I2.4 

(-)I2.3 
I2.3 

(-)I2.2 
I2.2 

(-)I2.1 
I2.1 

(-)I2.0 
I2.0 

NC 
NC 
69 
68 
67 
66 
- 

21 
- 

20 
NC 
NC 
- 

35 
- 

34 
- 

33 
- 

32 

NC 
NC 

Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 

GND I2.6 
Interrupt 1 In 

GND I2.5 
Interrupt 0 In 

NC 
NC 

GND I2.3 
Digital Input 
GND I2.2 

Digital Input 
GND I2.1 

Digital Input 
GND I2.0 

Digital Input 

D Zone 
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o
 P

in
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n
  

GND 
A2.7 
A2.6

1
 

A2.5
1
 

Q/Vdc 
COM(-) 

Q2.7 
Q2.6

1
 

Q2.5
1
 

Q2.4 
Q2.3 
Q2.2 
Q2.1 
Q2.0 

GND 
NC 
13  
12 
- 
- 

NC 
13 
12 
NC 
49 
48 
47 

53 

GND 
- 

Analog Out 
Analog Out 

External Isolated Out Vdc 
External Isolated Out GND 

- 
Digital/PWM Out 
Digital/PWM Out 

- 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

 
 
 
Configuration Switch*  
(see section 8 to select the  correct 
configuration for outputs). 
 
 
 
 
Analog Outputs 
 
Voltage Supply/Reference for 
Digital/PWM Outputs (isolated) 
 
PWM/Digital Outputs 

Led indicator I/Os state 

Top Zone 
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 A Zone: Communications  8.1

 

 

 

 

 

 

 

 

 

 

 

4. SCL/I2.6: Choosing between SCL or the input I2.6. If this switch is ON, it enables the I2.6    

input and disables the SCL. If this switch is OFF, it enables SCL and disables I2.6. If it is a Relay 

Shield I2.6 is changed for I2.1. 

3. SDA/I2.5: Choosing between SDA or the input I2.5. If this switch is ON, it enables the I2.5    

input and disables the SDA. If this switch is OFF, it enables SDA and disables I2.5. If it is a Relay 

Shield I2.5 is changed for I2.0. 

2. RX1/I1.6: Choosing between RX1 or the input I1.6. If this switch is ON, it enables the I1.6    

input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6.  

1. TX1/I1.5: Choosing between TX1 or the input I1.5. If this switch is ON, it enables the I1.5    

input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.5. 

LEFT ZONE 

Switch Analog Shield 

 ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 

C ZONE 

RX1/I1.6 I1.6 RX1 

TX1/I1.5 I1.5 TX1 

B ZONE 

Pin 3/I0.6 I0.6 Pin 3 

Pin 2/I0.5 I0.5 Pin 2 

uSD & RS-485 

D53(SD) Q2.0 SD 

FD RS-485 HD HD FD 



 

4. Pin 3/I0.6:  Choosing between Pin 3 or the input I0.6. If this switch is ON, it enables the I0.6 

input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables I0.6. 

 

3. Pin 2/I0.5: Choosing between Pin 2 or the input I0.5. If this switch is ON, it enables the I0.5 

input and disables the Pin 2. If this switch is OFF, it enables Pin 3 and disables I0.5. 

 

2. D53(SD):  If this Switch is OFF, it enables the Chip Select of the microSD socket and disables 

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD 

can’t be used. 

*If the D Zone is an Analog Shield, Q2.0 is also related with D53. Being D53 in ON Mode the SD card MUST NOT be 

used because it can corrupt the microSD. 

1. FD RS-485 HD:  Choosing between FD or HF. If this switch is ON, it enables the Half Duplex 

(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables 

HD. 

 

 

 

 

 

 

 

1. RTC SDA: This switch enables the communication to communicate with the RTC 

using I2C. Having this switch in ON mode it actives this communication, 

whereas if it is in OFF mode it disables the I2C to reach the RTC.  

 

2. RTC SCL: This switch enables the communication to communicate with the RTC 

using I2C. Having this switch in ON mode it actives this communication, 

whereas if it is in OFF mode it disables the I2C to reach the RTC.  

 

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter 

if it is in ON mode or OFF mode. 

 

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter 

if it is in ON mode or OFF mode. 

 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 



 

 

 B Zone: Analog Shield 8.2

 

 

 

 

 

 

 

 

 

 

For the Analog Shield (Zone B & Zone C) if a switch is set to ON, it can only act as Digital 

Output. If it is set to OFF it can only act as an Analog Output. 

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with Q0.X, being X any number of the tables above.  

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with A0.X, being X any number of the tables above.   

 

 I/Os 5V pins 9

The MDUINO PLC ARDUINO ETHERNET & WIFI & BLE 58 I/Os ANALOG/DIGITAL PLUS has some 

of the Mega board pins available.  These pins can be programmed according to Arduino 

features such as I/Os operating at 5V or any additional features present in the pins (for 

example I2C communication in pins SCL and SDA). As this pins are directly connected to the 

Arduino Mega board they are not as well protect as the normal inputs. These pins are mainly 

meant to be used as prototyping. 

The Arduino board available pins are summarized in the table below. In order to access some 

of these pins the configuration switch must be set to OFF position (see section 8) and some 

extra considerations must be taken in consideration when using these pins. 

B ZONE 

SWITCH ON OFF 

NC - - 

Q0.7 Q0.7 A0.7 

Q0.6 Q0.6 A0.6 

Q0.5 Q0.5 A0.5 

C ZONE 

SWITCH ON OFF 

NC - - 

Q1.7 Q1.7 A1.7 

Q1.6 Q1.6 A1.6 

Q1.5 Q1.5 A1.5 

D ZONE 

SWITCH ON OFF 

NC - - 

Q2.7 - - 

Q2.6 Q2.6 A2.6 

Q2.5 Q2.5 A2.5 

M-Duino terminal Arduino pin Enable Arduino pin 

SCL 21 Communication switch: OFF 

SDA 20 Communication switch OFF 

RX0 0  



 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Mega board. 

A part from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

In the WiFi & BLE Controller, Serial 1(Tx1 & Rx1)  is used to communicate through the ESP32 

integrated in the MDUINO PLC ARDUINO ETHERNET & WIFI & BLE 58 I/Os ANALOG/DIGITAL 

PLUS.  

 

 I2C pins – SDA/SCL 9.1

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case 

it reads 5V when nothing is connected. The pull-up configuration is stablished by default in 

these pins. 

 If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up 

inputs. 

*IMPORTANT: I2.5 & I2.6 are not pull-up inputs although they are referred to the I2C pins 

(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the 

same behaviour as the other inputs.  

 Serial 0 – RX0/TX0 9.2

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in 

case that all the 5V pins are already performing a function. This is because they are shared 

with the USB interface. If using these pins, the USB communication cannot be working at the 

same time. When the PLC is not installed, the USB communication is normally required for 

debugging, uploading and intercommunicating with the Ethernet controller. If using both 

interfaces at the same time the Arduino board will get blocked.  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 Serial 1 – RX1/TX1 9.3

TX0 1  

RX1 19 DON’T USE! 

TX1 18 DON’T USE!  

MISO 50  

MOSI 51  

SCK 52  

Pin 3 3 Communication switch: OFF 

Pin 2 2 Communication switch: OFF 



 

In the WiFi & BLE Controller, Serial 1 is used to communicate through the ESP32 integrated in 

the MDUINO PLC ARDUINO ETHERNET & WIFI & BLE 58 I/Os ANALOG/DIGITAL PLUS.  

DON’T USE SERIAL 1 

 

 SPI – MISO/MOSI/SCK 9.4

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the 

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours 

cannot happen at the same time as the Ethernet would not work. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 

 Pin 2/Pin 3 9.5

These pins are only referred to the inputs I0.5/I0.6. If the switch configuration is in OFF 

position the pins Pin 2/Pin 3 will be available. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 
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 RS-232 10.1

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16 

and 17 of the Arduino Mega).  

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not 

matter the configuration of the switches to implement a RS-232 communication. 

Using the boards of Industrial Shields, there is a library that simplifies the RS-232 

implementation. 

  

 RS-485 10.2

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart 

below.  

Function Arduino Pin 

DI 14 

RO 15 

RE 11 

DE 46 

 

For the RS-485 communication protocol there is only one switch that affects in this 

communication. The RS-485 protocol will be always enabled, the only switch that affects is the 

one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485 

Half Duplex or RS-485 Full Duplex (RS-422). 

Using the boards of Industrial Shields, there is a library that simplifies the RS-485 

implementation. 

 

 I2C 10.3

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino Family. The pull-up 

resistor is already implemented in the PCB.  

I2C communication is configured by switches, so the switches must be configured in order to 

enable the I2C communication. 

 

 

To enable I2C the switches SCL/I2.6(I2.1) & SDA/I2.5(I2.0) must be set to OFF mode. In this 

mode the inputs are totally disabled and the I2C is now enabled. 



 

Industrial Shields does not provide any library to implement the I2C as it can be used the 

standard library of Arduino called Wire. 

 

 SPI 10.4

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO, 

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely, 

each of the connected devices will have a single and dedicated SS pin.  

Function M-Duino connection Mega board pin 

MISO 50 S0 50 

MOSI 51 SI 51 

CLOCK 52 SCK 52 

Reset Reset Reset 

SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3 

Check the switch configuration at section 8 to enable SS pins. 

 

 TTL 10.5

M-Duino has one TTL port, RX0/TX0 (RX1/TX1 is used for Wi-Fi and BLE communication). TTL0 

is accessed with the function Serial (pins 0 and 1 of the Arduino Mega).  

 

 Ethernet 10.6

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible 

with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible 

with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS 

Arduino Mega pin 10).  

 

 RTC 10.7

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol 

communication, so it is required to have enabled the I2C protocol.  

4 switches have to be configured in order to enable the RTC features: 

 

RTC SCL & RTC SDA must be set to ON mode to enable 

the I2C wires to the RTC. If they are in OFF mode, the 

Arduino won’t communicate with the RTC. 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 



 

 

 

I2C must be enabled in order to communicate with the 

RTC. See section 11 I2C to enable it. 

 

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation 

called RTC. 

 uSD 10.8

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol 

is always enabled, as there are no switches that configure it. However, there is a switch that 

must be placed to ON mode in order to communicate with the uSD: 

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables 

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD 

can’t be used. 

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of 

the PLC, it is required to open the plastic found in the frontal part and the socket is located 

under the supply of the Arduino. 

 

 

 

 

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation 

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to 

select the Chip Select of the uSD chip.  

  

 

 

 

 

 

 

Switch Analog Shield 

 ON OFF 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 

Switch Analog Shield 

 ON OFF 

D53(SD) Q2.0 D53(SD) 



 

 WiFi & BLE  10.9

 

The WiFi and Bluetooth integrated module consists in a single 2.4 GHz Wi-Fi and Bluetooth 
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to 
achieve the best power and RF performance, showing robustness, versatility and reliability in a 
wide variety of applications and power scenarios. Some applications are Generic Low-power 
IoT Sensor Hub, Generic Low-power IoT Data Loggers and Mesh Network. 
It is designed for Internet-of-Things (IoT) applications.  

 

10.9.1 General Specifications: 

 

Wi-Fi 
 802.11 b/g/n  
 802.11 n (2.4 GHz), up to 150 Mbps 

Bluetooth 

 Bluetooth 4.2 BR/EDR BLE dual mode controller 
 +12 dBm transmitting power 
 NZIF receiver with -97 dBm BLE sensitivity 

 
 
 

10.9.2 WiFi & Bluetooth Module Configuration 

 

In order to configure the WiFi & BLE module, you must connect it to a PC. 
To connect it you will need a micro USB to USB cable. 
 
The slot for the micro USB input is located on the right side of your equipment. 
 
To load the program into the ESP32 you have to install the board on the Arduino IDE software.  
Go to File >  Preferences and into Additional Boards Manager URLs add the next 

URL: https://dl.espressif.com/dl/package_esp32_index.json 

*If you already have one URL put it next to the other separeted by coma, like in the image 
below. 

https://dl.espressif.com/dl/package_esp32_index.json


 

 

 
 

Now you are able to install the board. Go to Tools > Boards > Boards Manager and search by 
ESP32.  
Will appear the esp32 by Espressif Systems. Install it.   
 
Once it is installed go to Tools > Boards and choose ESP32 Dev Module 



 

 

 

The internal connections between the ESP32 module and the Arduino Mega are the following: 

 

Arduino Mega Pinout ESP32 Pinout 

5Vdc Vcc 

GND GND 

Tx1 (Pin 18) TxD 

Rx1 (Pin19) RxD 

 

 

WiFi and Bluetooth are always enabled as there are no switches that configure it.  

The WiFi and Bluetooth module uses Serial1 for communication. 

More information: https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-
bluetooth-module-esp32-devkit-v1-133 

 

https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
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Digital Output Waveform: 

 

 

 

 

 

 

 

Digital Out-put Turn-off: 

 

PWM Waveform:  

 

 



 

Analog Out Turn On: 

 

Analog Out Turn-Off: 

 

Analog /Digital input Turn-on: 
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 Connector details: 13

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 
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anical 

Characteristics 

 

- Dimension : 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General


 

 

 

 

 

 

 

 

 
 

- DIN Rail mounting 
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Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 
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